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Conductivity Part 1:  
Electrolytes and Non-Electrolytes 

 
In this experiment, you will discover some properties of strong electrolytes, weak electrolytes, 
and non-electrolytes by observing the behavior of these substances in aqueous solutions. You 
will determine these properties using a Conductivity Probe. When the probe is placed in a 
solution that contains ions, and thus has the ability to conduct electricity, an electrical circuit is 
completed across the electrodes that are located on either side of the hole near the bottom of the 
probe body (see Figure 1). This results in a conductivity value that can be read by the computer. 
The unit of conductivity used in this experiment is the microsiemens per centimeter, or µS/cm. 

 
Figure 1 

 
The size of the conductivity value depends on the ability of the aqueous solution to conduct 
electricity. Strong electrolytes produce large numbers of ions, which results in high conductivity 
values. Weak electrolytes result in low conductivity, and non-electrolytes should result in no 
conductivity. In this experiment, you will observe several factors that determine whether or not a 
solution conducts, and if so, the relative magnitude of the conductivity. Thus, this simple 
experiment allows you to learn a great deal about different compounds and their resulting 
solutions. 

In each part of the experiment, you will be observing a different property of electrolytes. Keep in 
mind that you will be encountering three types of compounds and aqueous solutions: 

Ionic Compounds 

These are usually strong electrolytes and can be expected to 100% dissociate in aqueous 
solution. 
  Example:  NaNO3(s) ! → !  Na+(aq) + NO3

–(aq) 

Molecular Compounds 

These are usually non-electrolytes. They do not dissociate to form ions. Resulting solutions do 
not conduct electricity. 
  Example:  CH3OH(l) ! → !  CH3OH(aq) 
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Molecular Acids 

These are molecules that can partially or wholly dissociate, depending on their strength. 
  Example:  Strong electrolyte H2SO4 ! → !  H+(aq) + HSO4

–(aq)  (100% dissociation) 

  Example:  Weak electrolyte HF ← →#  H+(aq) + F–(aq)  (<100% dissociation) 

PRELAB QUESTIONS: 

1. What is an electrolyte? 

2. What is the difference between a molecular and ionic compound? 

3. What is a polyprotic acid?  Give an example of a polyprotic acid? 

OBJECTIVES 
In this experiment, you will 

• Write equations for the dissociation of compounds in water. 
• Use a Conductivity Probe to measure the conductivity of solutions. 
• Determine which molecules or ions are responsible for conductivity of solutions. 
• Investigate the conductivity of solutions resulting from compounds that dissociate to 

produce different numbers of ions. 
 

MATERIALS 
From the Stockroom (or Your Instructor): Found in the Lab or Your Locker: 

Vernier LabPro interface box-(LL)* Ring Stand 
Power cord for LabPro interface-(ALL) Buret Clamp and Probe Clamp 
USB Cable for LabPro interface H2O (deionized and tap) 
Ethernet Cable 0.05 M NaCl 
Laptop Computer-(CMP) 0.05 M CaCl2 
Vernier Conductivity Probe-(CON) 0.05 M AlCl3 
 0.05 M HC2H3O2 

Found in the Lab or Your Locker: 0.05 M H3PO4 
30,50, and 250 mL beakers 0.05 M H3BO3 
wash bottle with deionized water 0.05 M HCl 
KimWipe tissues 0.05 M CH3OH (methanol) 
2.00 mL Microburet 0.05 M C2H6O2 (ethylene glycol) 
  

*Indicates stockroom abbreviation for device. 
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STOCKROOM EQUIPMENT 
 
1.  From the Chemistry stockroom check out the equipment listed in the table on the previous 

page. 
 
PROCEDURE 
1. Obtain and wear goggles! CAUTION: Handle the solutions in this experiment with care. Do 

not allow them to contact your skin. Notify your teacher in the event of an accident.  

2. Setting up the equipment: 

a. Connect the conductivity probe to the LabPro interface box through channel 1(refer to 
Appendix 1).  

b. Connect the LabPro interface box to the power outlet with the power cord.  The LabPro 
will beep to indicate it is ready.   

c. Connect the LabPro interface box to the laptop computer using the USB cable (refer to 
Appendix 1). The USB ports are found in the back of the laptop on the right hand side 
when the screen is facing you.   

d. Connect the computer to the Ethernet using the Ethernet cable and the port located on the 
lab bench.  The Ethernet port for the computer is located in the back of the laptop on the 
right hand side when the screen is facing you. 

3. IMPROTANT: Make sure that the conductivity probe is set on the 0-20,000 µS/cm position.  
If you receive an error message stating that the settings are incorrect/different, it is because 
the toggle on the probe is in the wrong position. Clamp the probe on to the ring stand as 
illustrated in Figure 1.  

4. IMPROTANT: Prepare the computer to monitor conductivity by opening the file 
“Conductivity 1” from the Chemistry 1A desktop folder. 

5. From the fume hood obtain a set of the conductivity solutions in the small 30 mL bottles. The 
solutions are: 0.05 M NaCl, 0.05 M CaCl2, 0.05 M AlCl3, 0.05 M HC2H3O2, 0.05 M H3PO4, 
0.05 M H3BO3, 0.05 M HCl, 0.05 M CH3OH, and 0.05 M C2H6O2.   

 6. Measure the conductivity for each of the solutions. 
a. Before testing the first solution, clean the probe by surrounding it with the 250 mL beaker 

and rinsing it with deionzed water from a wash bottle. Blot the outside of the probe end 
dry using a KimWipe tissue. It is not necessary to dry the inside of the hole near the probe 
end. 

b. Measure the conductivity of the Group A solutions (0.05 M NaCl, 0.05 M CaCl2, and 
0.05 M AlCl3,). Carefully raise the first bottle with the 0.05 M NaCl solution up around 
the Conductivity Probe until the hole near the probe end is completely submerged in the 
solution being tested. Important: Since the two electrodes are positioned on either side of 
the hole, this part of the probe must be completely submerged. 

c. Briefly swirl the bottle contents. Once the conductivity reading has stabilized, record the 
value in your data table. Note: It is normal for the conductivity reading to fluctuate to a 
small degree.  

d. Once you have obtained a conductivity reading, recap the bottle and return the solution to 
the fume hood.  
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e. Before testing the next solution, clean the probe by again rinsing it with deionzed water 
from a wash bottle. Blot the outside of the probe end dry using a tissue. Remember, it is 
not necessary to dry the inside of the hole near the probe end. 

 
7. Measure the conductivity of the Group B solutions. These include 0.05 M H3PO4, 0.05 M 

HC2H3O2, 0.05 M H3BO3, and 0.05 M HCl. Repeat the Step 6 procedure. 

8. Measure the conductivity of the Group C solutions or liquids. These include 0.05 M CH3OH, 
0.05 M C2H6O2, distilled H2O, and tap H2O. Repeat the Step 6 procedure. 

 

DATA TABLE 

Solution Conductivity (µS/cm) 
A - CaCl2  

A - AlCl3  

A - NaCl  

B - HC2H3O2  

B - HCl  

B - H3PO4  

B - H3BO3  

C - H2Odistilled  

C - H2Otap  

C - CH3OH  

C - C2H6O2  

 
 
PROCESSING THE DATA 
1. Based on your conductivity values, do the Group A compounds appear to be molecular, 

ionic, or molecular acids? Would you expect them to partially dissociate, completely 
dissociate, or not dissociate at all?  

2. Why do the Group A compounds, each with the same concentration (0.05 M), have such 
large differences in conductivity values? Explain.  Write an equation for the dissociation of 
each compound in water.  

3. In Group B, do all four compounds appear to be molecular, ionic, or molecular acids? 
Classify each as a strong or weak electrolyte, and arrange them from the strongest to the 
weakest, based on conductivity values. 

4. Write an equation for the dissociation of each of the compounds in Group B. Use ! → !  for 
strong; ← →#  for weak. Remember that some of the acids are polyprotic and will have more 
than one ionization step! 
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5. Examine the conductivity data for H3PO4 and H3BO3, These are polyprotic acids.  Write out 
the dissociation steps for these acids (see your textbook). What are possible reasons for the 
differences observed in conductivity for these two compounds? Explain.  

6. In Group C, do all four compounds appear to be molecular, ionic, or molecular acids? Based 
on this answer, would you expect them to dissociate? 

7. How do you explain the relatively high conductivity of tap water compared to a low or zero 
conductivity for deionized water? 

8. Did aqueous methanol, CH3OH, have the same conductivity value as aqueous ethylene 
glycol, C2H6O2? Should they have the same or different conductivity values? Explain. 
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Conductivity Part 2:  
The Effect of Concentration 

If an ionic compound is dissolved in water, it dissociates into ions and the resulting solution will 
conduct electricity. Dissolving solid sodium chloride in water releases ions according to the 
equation: 

NaCl(s) ! → !  Na+(aq) + Cl–(aq) 

In this experiment, you will study the effect of increasing the concentration of an ionic 
compound on conductivity. Conductivity will be measured as concentration of the solution is 
gradually increased by the addition of concentrated NaCl drops. The same procedure will be 
used to investigate the effect of adding solutions with the same concentration (1.0 M), but 
different numbers of ions in their formulas: aluminum chloride, AlCl3, and calcium chloride, 
CaCl2. A computer-interfaced Conductivity Probe will be used to measure conductivity of the 
solution. Conductivity is measured in microsiemens per centimeter (µS/cm). 

OBJECTIVES 
In this experiment, you will 

• Use a Conductivity Probe to measure the conductivity of solutions. 
• Investigate the relationship between the conductivity and concentration of a solution. 
• Investigate the conductivity of solutions resulting from compounds that dissociate to 

produce different number of ions. 
 
PROCEDURE 
1. Obtain and wear goggles! CAUTION: Handle the solutions in this experiment with care. Do 

not allow them to contact your skin. Notify your teacher in the event of an accident. 

2. Setting up the equipment: 

a. Connect the conductivity probe to the LabPro interface box through channel 1(refer to 
Appendix 1).  

b. Connect the LabPro interface box to the power outlet with the power cord.  The LabPro 
will beep to indicate it is ready.   

c. Connect the LabPro interface box to the laptop computer using the USB cable (refer to 
Appendix 1). The USB ports are found in the back of the laptop on the right hand side when 
the screen is facing you.   

d. Connect the computer to the Ethernet using the Ethernet cable and the port located on the 
lab bench.  The Ethernet port for the computer is located in the back of the laptop on the right 
hand side when the screen is facing you. 

3. IMPORTANT: Make sure that the conductivity probe is set on the 0-2000 µS/cm position.  
(This is a different setting than used in the first part of the experiment). If you receive an 
error message stating that the settings are incorrect/different, it is because the toggle on the 



  

7 

probe is in the wrong position. Clamp the probe on to the ring stand as illustrated in Figure 1. 
In addition, also use a buret clamp to hold the 2.00 mL Microburet. 

4. IMPORTANT: Prepare the computer to monitor conductivity by opening the file 
“Conductivity 2” from the Chemistry 1A desktop folder.  (This is a different file than used 
in the first part of the experiment.) 

5. Using a graduated cylinder add 35.0 mL of deionized water to a clean 50 mL beaker. Using a 
25 mL beaker obtain about 10-15 mL of 0.05 M NaCl solution from the large stock bottle.  

6. Clean the probe by surrounding it with the 250 mL beaker and rinsing it with deionzed water 
from a wash bottle. Blot the outside of the probe end dry using a KimWipe tissue. It is not 
necessary to dry the inside of the hole near the probe end. 

 7. Before adding any drops of solution: 
a. Click . 
b. Carefully raise the beaker and its containing the 35.0 mL of deionized water up around the 

Conductivity Probe until the hole near the probe end is completely submerged in the 
solution being tested. Important: Since the two electrodes are positioned on either side of 
the hole, this part of the probe must be completely submerged. 

c. Monitor the conductivity of the deionized water until the conductivity reading stabilizes. 
d. Click , and then lower the beaker away from the probe. Type “0.00” (for 0.00 mL’s 

added)  in the edit box that appears on the screen.  Press the ENTER key to store this data 
pair. This gives the conductivity of the water before any salt solution is added. 

 
 8. You are now ready to begin adding salt solution. 

a. Rinse and fill the 2.00 mL microburet with 0.05 M NaCl solution. 
b. Add 0.10 mL of 0.05 M NaCl solution to the 35.0 mL of distilled water.  
c. Raise the beaker until the hole near the probe end is completely submerged in the solution. 

Swirl the solution briefly. 
d. Monitor the conductivity of the solution until the reading stabilizes. 
e. Click , and then lower the beaker away from the probe. Type “0.10” (the total 

volume in mL’s added) in the edit box and press ENTER. 
 
9. Repeat the Step 8 procedure by adding another 0.10 mL of 0.05M NaCl to the beaker, but 

this time entering “0.20” (the total volume in mL’s added). 

10. Continue this procedure, adding 0.10 mL portions of 0.05 M NaCl solution, measuring 
conductivity, and entering the total volume added—until a total of 0.80 mL has been added. 
At anytime you may click on the  button located just below the menu bar to expand the 
graph. 

11. Click  when you have finished collecting data. Dispose of the beaker contents as 
directed by your teacher. Rinse the probe tip with deionized water from a wash bottle. 
Carefully blot the probe dry with a tissue. 

12. Important: From the Experiment menu, choose Store Latest Run. This stores the data so it 
can be used later, but it will still be displayed while you do your second and third trials. 

13. Repeat Steps 6-12, this time using 0.05 M AlCl3 solution in place of 0.05 M NaCl solution. 
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14. Repeat Steps 6-12, this time using 0.05 M CaCl2 solution.  

15. Click on the Linear Fit button, . Be sure all three data runs are highlighted, then click 
. A best-fit linear regression line will be shown for each of your three runs. In your 

data table, record the value of the slope, m, for each of the three solutions. (The linear 
regression statistics are displayed in a floating box for each of the data sets.)  

16. To print a graph of concentration vs. volume showing all three data runs: 
a. Label all three curves by choosing Text Annotation from the Insert menu, and typing 

“sodium chloride” (or “aluminum chloride”, or “calcium chloride”) in the edit box. Then 
drag each box to a position near its respective curve. 

b. From the File menu select Print Graph. Print a copy of the graph, with all three 
regression lines displayed. Enter your name(s) and the number of copies of the graph you 
want. Make certain that each lab partner has his/her own copy. 

c. From the File menu select Print Data. Print a copy of the data table making sure that all 
three sets of data are present. Make certain that each lab partner has his/her own copy 

 
DATA TABLE 

Solution Slope, m 
0.05 M NaCl  

0.05 M AlCl3  

0.05 M CaCl2  

 
 
PROCESSING THE DATA 
1. Calculate the concentration of chloride ion in each of the original 0.05 M solutions. Calculate 

the concentration of the cation in each of the original 0.05M solutions.  What is the total ion 
concentration for each original 0.05 M solution?  

2. Describe the change in conductivity as the concentration of the NaCl solution was increased 
by the addition of NaCl drops. What kind of mathematical relationship does there appear to 
be between conductivity and concentration? 

3. Write a mathematical equation for each line.  Remember to include units for the slope and y-
intercept and write out what the x and y variables represent: “x” and “y” should not appear in 
the equation. 

4. Which graph had the largest slope? The smallest? Since all solutions had the same original 
concentration (0.05 M) and were added to 35.0 mL of water, what accounts for the difference 
in the slope of the three plots? Explain. 

5. Ideally what should the ratio between the three slopes be? What are your actual experimental 
ratios? Give possible reasons for any observed variations from these ratios. 

6.   Using the equation developed in question number 3, calculate the conductivity of the solution 
after 1.30 mL of 0.05 M CaCl2 has been added to the 35.0 mL of water.  


